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What is an abstract? (Publication Manual of the APA, 7th Ed., 2020)

 “A brief, comprehensive summary of the contents of the paper” 

(Publication Manual of the APA, 7th Ed., 2020, pg. 73)

 GOOD abstracts have these qualities:

 Accurate – “…reflects the purpose and content of the paper.”

 Nonevaluative – Not an “opinion paper;” reports on the data

 Coherent and Readable – Specific, clear, active, and deliberative writing

 Concise – Includes the top 4-6 important “concepts, findings, or 

implications”



The Four C’s - Reiterated
Abstracts should be:

 Complete

 Covers the major parts of the project

 Concise

 Avoid excess wordiness, unnecessary information, and narration

For example, "It is my opinion that/I have concluded/the main point supporting 
my view concerns/or certainly there is little doubt as to..." 

 Meets the maximum word count – 300 words

 Clear

 Readable

 Well organized

 Avoid jargon/slang – overly technical language

 NO spelling or grammatical errors

Use Word’s “ABC Spelling & Grammar” check under the “Review” tab OR

Download the free program called Grammarly (https://www.grammarly.com/)

 Cohesive

 Flows smoothly

https://www.grammarly.com/


Abstract Formatting Instructions

 Use either Times New Roman or Arial font

 12 pt. font, Single-Spaced

 Center and bold the title 

 Add space below title, and then list authors’ information

 Underline the primary author

 Put “(Faculty Mentor)” after faculty mentor’s name [e.g., Grace 

Abolaji, Ph.D. (Faculty Mentor)]

 Left-justify the body of the abstract

 Within the abstract, add section terms in bold (e.g., Background, 

Aims or Objectives, Methods and Materials, Results, Conclusion)

 Add space below abstract

 List approximately five “Keywords”



Format: Quantitative Data (1 of 3)

(Publication Manual of the APA, 7th Ed., 2020, pp 77-78)

 Abstracts detailing QUANTITATIVE DATA should meet the 

following format:

Background, Objectives/Aims: 

State the problem under investigation, including main 

hypotheses.

Participants:

Describe subjects or participants.

Specify pertinent characteristics for the study

Animal Research: Include genus and species

Describe participants in greater detail in the BODY of the 

paper – not the abstract



Format: Quantitative Data (2 of 3)

(Publication Manual of the APA, 7th Ed., 2020, pp 77-78)

 QUANTITATIVE DATA Abstracts

Study Methods and Materials: 

Research design (e.g., experiment, observational study, 

etc.)

Sample size (n=XX)

Materials used (e.g., instruments, apparatus, etc.)

Outcome measures 

Data-gathering procedures, including source of 

secondary data. Indicate if study is secondary data 

analysis.



Format: Quantitative Data (3 of 3)

(Publication Manual of the APA, 7th Ed., 2020, pp 77-78)

 QUANTITATIVE DATA Abstracts

Findings/Results

Report findings.

Include effect sizes, confidence intervals, or statistical 

significance levels

Conclusion

State conclusion – beyond just the results

Report implications or applications

 Identify five keywords



Quantitative 

Data Abstract 

Example

Student 

presentation at the 

2019 14th Annual 

PVAMU Research 

Symposium

(Modified for this 

training)

The Student-Instructor Tango: Understanding the relationship between Rapport, Self-

concept, and Course engagement 
 

Daniel Vega, Riley Martin, Luke Whiteley, Connor Smith  

Katherine Wickes, Ph.D. and Benjamin White (Faculty Advisors)  

 

Blinn College 

 

Background: Student success has become a key goal of community colleges, but what factors 

drive success within a classroom?  Prior research found that both teacher behaviors and student 

traits impact success within a classroom (Komarraju, 2013; Lammers & Gallaspy 2013).  

Students’ perception of their instructor’s communication skills, positive rapport, and are caring 

and supportive positively impact their ratings of instructors and course performance (Lammers & 

Gallaspy 2013; Keeley, Smith, & Buskist, 2006; Wilson, Ryan, & Pugh, 2010). Prior studies 

often measure student success in terms of final course grade and fail to account for student 

variables that may impact success (Komarraju, 2013). Aims: Current research examines the 

relationship between instructor rapport, academic self-concept, and course engagement in 

community college students. Materials and Methods: Participants were 194 community college 

students who completed a 96-question survey to measure academic self-concept, ratings of 

teacher behaviors, instructor rapport, and course engagement.  Results: Students’ academic self-

concept was related to their global course engagement (r(193) =0.20, p<.05).  Instructor 

behaviors and traits were related to the level of engagement that students reported. Instructor 

rapport was positively related to both global course engagement (r(193) = 0.18, p<.05), and 

course level engagement (r(193)=0.38, p<.05).  Rapport related to how students perceived their 

instructors; high levels of rapport correlated with endorsement of positive teacher behaviors 

(r(193) = 0.65, p < .05), and student ratings of academic self-concept (r(193) = 0.17, p<.05). 

Students’ GPA related to academic self-concept (r(193) = 0.21, P<.05) but did not relate to 

rapport or teacher behavior. Conclusion: These findings indicate that positive teacher attributes 

can strengthen student engagement within a course and that engagement can have positive 

carryover effects into other courses.  Future research is needed to examine if there are specific 

teacher behaviors that are most likely to impact rapport and to examine the findings apply to 

other settings, such as online classes. 

 

Keywords: Student Success, Rapport, Self-Concept, Course Engagement 



Quantitative 

Data Abstract 

Example

Student 

presentation at the 

2019 14th Annual 

PVAMU Research 

Symposium

(Modified for this 

training)

The Evaluation of Vegetable Amaranth in Southeast Texas 

 

Kolade Adelaja, Eric Obeng, Aruna Weerasooriya, Godson Osuji 

Peter A.Y. Ampim, Ph.D. (Faculty Advisor) 

 

College of Agriculture and Human Sciences, Prairie View A&M University 

 

Background: Vegetable amaranth (Amaranthus spp.) is a leafy vegetable with high nutritive 

value, and has the ability to thrive under drought conditions. It is also a niche crop with 

tremendous potential as an alternative crop for small-scale producers in Texas. Objective: The 

objective of this study was to evaluate five varieties of vegetable amaranth and to identify 

suitable varieties for cultivation in Texas. Materials and Methods: Amaranth varieties 

including Red Leaf, White Leaf, Red Beauty, Red Garnet, and All Red were planted in spring 

2018 in a completely randomized design with three replications. The amaranth was broadcast 

seed at 1g per 1m2 plots carved out in plastic mulch covered beds supplied with drip irrigation. 

Harvesting was done every other week, 4 weeks after planting. Data collected including SPAD 

meter readings, insect damage score, and yield per plant was subjected to ANOVA at 5% 

significance level using JMP software. Results: Leaf chlorophyll content for Red Beauty was 

significantly greater than the other varieties. Red Leaf was significantly less susceptible to insect 

damage compared to All Red and White Leaf, and produced significantly more yield. Red 

Beauty and Red Garnet were intermediate in their susceptibility to insect damage and yield 

among the amaranth varieties evaluated. There was a significant negative correlation between 

insect damage score and yield per plant (p=0.0099) indicating that the higher the variety is 

susceptible to insect attack the lower the yield potential. Conclusion: These results suggest that 

Red Leaf amaranth could be the variety most suited for the humid and hot southwest Region of 

Texas. 

 

Keywords: Amaranth, Red Leaf Amaranth, Southeast Texas, Small-Scale Farmers, JMP software 



Format: Qualitative Data

(Publication Manual of the APA, 7th Ed., 2020, p. 95)

 Abstracts detailing QUALITATIVE DATA should meet the following 
format:

Objectives: 

State the problem/question/objectives under investigation

 Indicate

Study design (e.g., interview, focus groups, observation, etc.)

Theoretical approach (unless this is too complex to explain in the 
allotted word count)

Types of participants or data sources

Analytic strategy – How will you analyze the data

Main results/findings

Main implications or significance

 Identify five keywords



Qualitative 

Data 

Abstract 

Example

Kaveh, O., & Peyrovi, 

H. (2019). Exploring 

Iranian obese 

women’s 

perceptions of 

barriers to and 

facilitators of self-

management of 

obesity: A qualitative 

study. Journal of 

Family Medicine and 

Primary Care, 8(11), 

3538-3543

Exploring Iranian obese women’s perceptions of barriers to and facilitators of 

self-management of obesity: A qualitative study 

 

Omolhoda Kaveh1, Hamid Peyrovi2 
1 International Campus, Department of Medical-Surgical Nursing, Iran University of Medical 

Sciences, 2 Nursing Care Research Centre, Iran University of Medical Sciences, Tehran, Iran 

 

Abstract 

Background: Despite the clinical importance of self-management for obesity, poor compliance 

or noncompliance with the treatment regimen is a prevalent and persistent problem concerning 

people with obesity. Aims: The aim of this study was to explore Iranian obese women’s 

perceptions regarding the barriers to and facilitators of self-management of obesity. Materials 

and Methods: In this qualitative study, the participants were selected through purposeful 

sampling and the data were collected using semistructured interviews and focus groups between 

July 2017 and September 2018. Nineteen participants between the age range of 28–50 years and 

mean age of 38.56 years were interviewed. A focus group with seven participants was conducted 

to reach data saturation. All the interviews and the focus group were transcribed verbatim and the 

data were analyzed using constant comparative method. Results: The perceived barriers to obese 

women’s self-management for obesity were identified and classified into four main categories: 

(I) restrictions, (II) the pressures of being in the group, (III (temptation, (IV) resonators. In 

addition, seven main categories emerged as facilitators of obese women’s self-management for 

obesity: (I) achieving self-awareness, (II) positive consequences for weight loss success, (III) 

positive outcomes of exercise and physical activity, (IV) peers experience, (V) correct and 

logical program, (VI) autonomy and empowerment, and (VII) having supporting umbrella. 

Conclusion: This qualitative research provided a range of facilitators and barriers to 

self-management of obesity perceived by an obese woman to improve our understanding of the 

complex nature of self-management of obesity. Healthcare providers may consider this issue 

while designing and implementing appropriate interventions to upgrades woman’s ability for 

self-management of obesity.  

 

Keywords: Obesity, obesity self-management, qualitative research, women 



Format: Mixed Methods (1 of 2)

(Publication Manual of the APA, 7th Ed., 2020, p. 106)

 Abstracts detailing Mixed Methods should meet the following 

format:

Design

Mixed Methods design (e.g., Triangulation, Embedded, 

Explanatory, Exploratory, etc. design; Creswell, 2006, Chapter 

4)

Objectives

Describe the problem addressed

Describe the purpose for using Mixed Methods 

Participants

Types of participants or sources of data



Format: Mixed Methods (2 of 2)

(Publication Manual of the APA, 7th Ed., 2020, p. 106)

 Mixed Methods (con’t)

Study Methods

Analytic strategy: Describe your approach(es) to the inquiry

Describe how the intersecting approaches were combined

Results

Main results/findings

Conclusion

Report major implications and significance

 Identify five keywords



Mixed Methods 

Abstract 

Example

Roelofs, S., Edwards, N., 

Viehbeck, S., & 

Anderson, C. (2019). 

Formative, embedded 

evaluation to 

strengthen 

interdisciplinary team 

science: Results of a 4-

year, mixed methods, 

multi-county case 

study. Research 

Evaluation, 28(1), 37-

50. 

(Modified for this 

training)

Formative, embedded evaluation to strengthen interdisciplinary team science: Results of a 

4-year, mixed methods, multi-country case study 

 

Susan Roelofs1, Nancy Edwards1, Sarah Viehbeck2,3 and Cody Anderson4 

 
1 School of Nursing, University of Ottawa, 1 Stewart St., Room 212, Ottawa, ON K1N 6N5, 

Canada, 2 School of Public Health and Health Systems, University of Waterloo, 200 University 

Ave W, Waterloo, ON N2L 3G1, Canada, 3 Interdisciplinary School of Health Sciences, 

University of Ottawa, 1 Stewart St., Room 212, Ottawa, ON K1N 6N5, Canada; and 4 Research 

Advisor, Public Safety Canada, 269 Laurier Avenue West, Ottawa, ON K1A 0P8, Canada 

 

Design and Objectives: Evaluation of interdisciplinary, team science research initiatives is an 

evolving and challenging field. This descriptive, longitudinal, mixed methods case study 

examined how an embedded, formative evaluation approach contributed to team science in the 

interdisciplinary Research into Policy to Enhance Physical Activity (REPOPA) project, which 

focused on physical activity policymaking in six European countries with divergent policy 

systems and researcher–policymaker networks. We assessed internal project collaboration, 

communication, and networking in four annual data collection cycles with REPOPA team 

members. Methods: Data were collected using work package team and individual interviews, 

and quantitative collaboration and social network questionnaires. Interviews were content 

analyzed; social networks among team members and with external stakeholder were examined; 

collaboration scores were compared across 4 years using analysis of variance (ANOVA). Annual 

monitoring reports with action recommendations were prepared and discussed with consortium 

members. Results: Results revealed consistently high response rates. Collaboration and 

communication scores, high at baseline, improved slightly, but ANOVA results were 

nonsignificant. Internal network changes tracked closely with implementation progress. External 

stakeholders were primarily governmental, with a marked shift from local/provincial level to 

national/international during the project. Diversity (disciplinary, organizational, and geopolitical) 

was a project asset influencing and also challenging collaboration, implementation, and 

knowledge translation strategies. Conclusion: In conclusion, formative evaluation using an 

embedded, participatory approach demonstrated utility, acceptability, and researcher 

engagement. A trusting relationship between evaluators and other project members built on joint 

identification of team science objectives for the evaluation at project outset, codeveloping 

guiding principles, and encouraging team reflexivity throughout the evaluation. 

 

Keywords: formative evaluation; embedded evaluation; team science; interdisciplinary research; 

collaboration; diversity 



Before submitting your abstract

Make sure it is no more than 300 words. 

 Provide just the essential information

 Use language understandable by a non-specialist

 Avoid writing for an audience that includes only you and your 

professor

 Your faculty mentor work MUST approve the abstract before 

submitting it online

Only one abstract per person is allowed



Poster Presentation (Youngblood, 2019)

 Instructions (con’t)

Clear hypothesis or 

objective(s)

Give the reason for 

the study

No grammatical errors

Make conclusions from 

the study

Provide future ideas

 Purpose

Share knowledge

 Invite feedback

 Instructions

Must be visually appealing

 Include:

Graphs

Tables

Illustrations



Poster 

Organization

Sample



Developing Your Poster in PowerPoint
 Online instructions regarding how to create you poster : 

https://guides.lib.unc.edu/posters/pptwindows2016

 Launch PowerPoint and select a Blank Presentation

 Delete the existing boxes on the presentation slide – You will 
create your own

Click on the Design tab and select “Slide Size” on the 
“Customize” tab

Enter the size of your poster:  42 inches for Width and 33 
inches for Height

Click “OK”

 Add your individual text boxes using the “Insert” tab

 Time to create!

 Contact Center for Instructional Innovation and 
Technology Services (CIITS)

https://guides.lib.unc.edu/posters/pptwindows2016


Center for Instructional Innovation and 

Technology Services (CIITS)

 Please visit the CIITS site for standards and a template. 

https://www.pvamu.edu/dlearning/poster-printing/

 This office needs at least two weeks to prepare a poster. 

 Your advisor must approve. 

 You must submit use the above link to request your poster. Teach 

author must request their own poster and follow the guidelines. The 

symposium committee does not print posters.

https://www.pvamu.edu/dlearning/poster-printing/


Example 

of a 

Poster



Questions?

 First speak with your mentor – Remember – They MUST approve the 

abstract, poster and/or presentation!

 If that doesn’t help, contact us

 Grace Abolaji, gtabolaji@pvamu.edu

 Angela Broadus, adbroadus@pvamu.edu

 Susan Frazier-Kouassi, sfkousassi@pvamu.edu

mailto:gtabolaji@pvamu.edu
mailto:adbroadus@pvamu.edu
mailto:sfkousassi@pvamu.edu

